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To: District Fiscal Directors
District Payroll Users

From: Tami Camarena, Accounting Specialist
Laurie Sholl, Accounting Specialist

Re: Retirement Error Identification and Correction

As discussed during the Payroll User Group meeting on May 16, 2011, districts now have the
ability to generate a retirement errors report before payroll is processed for each period. It is
important for districts to run the RCA310-STRS Pre-list/F496 File in QSS, upload it into
CalSTRS/SEW and download the retirement errors report. All errors identified on this report
must be corrected prior to payroll closing for the district.

The procedure for running the F496 file in QSS is attached (Attachment A). The procedure
for uploading the file to CalSTRS/SEW is also attached (Attachment B). Please contact your
service team, if you encounter any difficulty in generating the report. Your service team can
also assist you if you are not sure as to how to correct errors.

Please share this information as deemed appropriate.

Approved by: Nimrat Johal- Director- District Business & Advisory Services

County Board of Education: Leon F. Beauchman, Michael Chang, Joseph Di Salvo, Julia Hover-Smoot, Grace H. Mah, Craig Mann, Anna Song
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Creating a prelist file in QSS to test retirement data on the STRS website.

District: 92 Request Payroll Pre-1list Reports 0SS/0ASIS

Year: Payroll name: [JM Pay date: [ENEENEARE] Period end: [ENERNEIRE

EOMREG EOM 12MOS DS-REG MO REG 01 02 11 12

EOMSUP EOM 12MOS DS-SUP MO SUP 01 02 11 12 99

E10606 EOM 10MOS OFF-JUN,JUL DS-REG MO REG 01 02 11 12 Begin at the
E10B607 10MOS OFF-JUL,AUG DS-REG MO REG 01 02 11 12

E11B06 EOM 11MOS OFF-JUN DS-REG MO REG 01 02 11 12 payro" prelist
E11B07 EOM 11MOS OFF-JUL DS-REG MO REG 01 02 11 12

E11608 EOM 11MOS OFF-AUG DS-REG MO REG 01 02 11 12 screen
E10R06 EOM 10MOS REPAY-JUN DS-REG MO REG 01 02 11 12

E10R07 EOM 10MOS REPAY-JUL DS-REG MO REG 01 02 11 12

E11R06 EOM 11MOS REPAY-JUN DS-REG MO REG 01 02 11 12

E11R07 EOM 11MOS REPAY-JUL DS-REG MO REG 01 02 11 12

E11R08 EOM 11MOS REPAY-AUG DS-REG MO REG 01 02 11 12

E10NBY 10MOS OFF-JUL,AUG NO ADD BEN MO REG 01 02 11 12

E11NB7 11 MO EES W/0 SMR BENEFITS MO REG 01 02 11 12

E09B06 © MONTH SEPT-MAY BEN 06-0/-08 MO REG 01 02 11 12

M\
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Creating a prelist file in QSS to test retirement data on the STRS website.

District: 92 Request Payroll Pre-1list Reports QSS/NASIS

Report title:
SSN Masking: {' ',0=none, 1-9=mask, L/R=ExtRefT)
Select Mum Totals
Y /N Copies Only
i 01 il PAY510 - Payroll Pre-list
01 H PAY240 - Payroll Fund Transfer
01 H PAY250 - Alpha Payroll Register
01 i PAY260 - Payroll Earnings Register
01 it PAY270 - Labor Distribution
01 il PAY290 - Emps. Paid First Time
01 il
01 1| | Choose the RCA310-— | pna)

01 M

] :: STRS Pre-list / F496 File
01 l':l (continue — F7)

N 1{] i - 0 0 O] 0 ) (3 []

HCA31U STHS Pre- llst / F496 File

Save a snapshot Tor comparison
PAY228 - Child Care Deductions

M\

N
Technology Services
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Creating a prelist file in QSS to test retirement data on the STRS website.

District: 92 Request Payroll Pre-1list Reports QSS/0ASIS

Optional Selection Criteria

Max HNet: Last Name: -

Ctl Grp: Pay Code:

Pay Loc: Ret Sys: BOC: Group: I
sshis: J- - ] k .- ] B .

Complete the box for the RCA310 (STRS/F496 File). You must
choose a file indicator 1-9 or A-Z that DOES NOT ALREADY EXIST.

Best practice would be to erase the files from QSS after you have

downloaded them, to avoid errors.
Comment Types: [ B B B OO O BB BN B BN Dates: [ - NS

=Tali cA320 (PERS/Data File) —

: D000 File: |
PAYG15

Vol-Ded Numbers From: 0000 to BO0E (0 - 9999 = All)
Save Snapshot

Snapshot: I Desc: N overurite: [

Your file will appear in the Personnel Downloader. QCC is strongly recommended for the next step ~

Technology Services

Santa Clara Courty
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Creating a prelist file in QSS to test retirement data on the STRS website.

Q5SS ControlCenter 92 - SANTA CLARA CO OFFICE OF ED ass/oasis [ |[@](%]
District ‘ear

File View Go Messages Window Help

Print Manager | Job Menu [ Utilities
System Admin

Finance

Fixed Assets [ Stores

— W2/ 1099

I_?ﬂ W2 [ 1099 Processing

— Human Resources [ Payroll

%i:ii‘;i:i:im In QCC, select the
# CA Retirement

— HR Reporting and Downloading
) R AR

=
I 6@ Personnel Downloader
P P o o

=
= Absence Tracking Job Menu

Personnel Downloader.

EE Benefits Management Job Menu
EE Payroll Job Menu
EE Position Contrel Job Menu

+ Master Files [ Utilities

;"  Budgeted FTE

A W

lj} HR Work Flow

SE. :l Professional Development [ruby [ web - Lodi Only]
% Substitute Teacher Tracking [Preview]

SE. :l Employee Self Service

Last Run: 05/12/2011 18:58:11 Yr:2011 Dist:92 Site:0 GS: W |5/13/2011 5:55 PM

A :
Technology Services

O Saota s county
= Ofice of Edwcabion



Creating a prelist file in QSS to test retirement data on the STRS website.
31 _,; s e ,-.- CAMTA CLARA O OFEICE OF BN NeC /M ACIC E E'@
HF e 4 X O BBEEE X EH o | &

Inspect
[Tl
Select Download D ownload/Global Settings T Field Selection
[ ] [ ]
Select the Data tab in the Personnel Downloader. Your file
L3 [ ] [ ]
will appear in the data list.
[ 4 [ [ d [ 4
The file will not appear in the print manager.
EMPEAS Employee Base List LYMML RTCPROD Global 1192010
FMLIST FRAMNELIN-MCEIMLEY EMPLOYEE LIST LYMML Global 2232010
LWLC2 EMPLOYEE LEAVE INFORMATION MIKLICAP |RTCE Global 172072010
PARI job title pay location control group LYMML RTCE@ Global 2/4/2010
PHIL PHIL BUCKC Global 312010
TBLIST TE EXPIRATION LIST HARRISE |RTCTEST Global 1201472009
TBTEST TB EXPIRATION LIST HARRISE |RTCTEST Global 12/14/2009
GIMA EMPLOYEE LIST FOR GIMA LYMML EMP @ District 1212010
| PDLOT0 ( 02): View - Any file. Update - Any file_ LVEAILY EReEA2 Sieb 523 20201 S5 S8 EH

~~

~
Technology Services

= $ fuomens




Creating a prelist file in QSS to test retirement data on the STRS website.

#% Personnel Downloader 97 - SANTA CLARA CO OFFICE

File Options Help

HEZ®Ee X0 EESXE E R

D ata file informatio
Download Definition m ategariesl

Data SubSe

Bges clude all files bt JECGER B LICKT Cateqary:

Name

District: 92

Request Payroll Pre-list Reports 085 /0ASIS

Optional Selection Criteria
Pay Code:

Hax MNet: Last Hame:
Ctl Grp:
Pay Loc:
SSNs: -I- - | 8 |

Ret Sys:
PAYS510/512/250

BOC: %Gr‘oup: [ |
N .

PAY510 Sort Option:
PAY512 Sort Option:

Pay type:
PAY250 Sort Option:

1-Hame 2-Pay Code 3-Ctl Grp 4-Pay Loc D: I
1-Use PAY510 sorts 2-by Exception

1-Name 2-Pay Code 3-Control Group 4-Pay Location

RCA500
Sort Opt: I {1=Ret Sys, 2=Error, 3=Pay Code) Comments: I (1=Print,2=Notify)
Error Codes:

Dates:

496 Flle) ————— RCA320 (PERS/Data File) —
0401110043011 NT-H

0 | svc: DE0@ Arr: D000 File: ]

RCASTO g
G055 011 1805311 1 Y

PAYB15

Vol-Ded Numbers From: [0 to §OOE (o -

9999 = All)

R5F495 | S5TRS PRE-PAYROLL F-456

Save Snapshot

snapshot: [N vesc: NN ovcrurite: |

Select the Data tab in the Personnel Downloader.

The file will always be identified with “SF496*” where “*” is the letter or
number you used in the request prelist launch screen.

Notice that there is no date indicator in the file list. Consider deleting the

file after you download to avoid errors.

The file will not appear in the print manager.




Creating a prelist file in QSS to test retirement data on the STRS website.

"'! Personnel Downloader 92 - SANTA CLARA CO OFFICE OF ED
File Options Help

WE BB +x 0 Eaax0 DRl

Data file information retneved.

Use the download tools to move the file to a location on
your local computer. Save your file as a *.txt

Download Definition @ Data ] LCategories ]

Diata SubSet ines to retrieve |Al

Arccess: ]Include all files _:] Dwner:é]BUCKE LJ Category: v] ig

| File Hame |Hame | Description | Records | -~ |category |Access |
¥ [SF4960 |RSF4‘36 |5|'RS PRE-PAYROLL F-435 928 PAY |Owner |

b

Save in: @ Desktop _'_J & 5 e EE-

BMV Documents
' My Computer
‘-} My Metwork Places
&t QS5 Control Center
g»‘-\dobe Reader X
& Microsoft Keyboard
Desktop ﬁ Microsoft Mouse
; Ii' HTC Sync

_J I delma doo

|Z)brenda pic

By Docuueris | Classy Toasters
IicPUG

%! [CQssUG 0222

My Computer < |

DRRREO

]

q

M\

File name: iSTRS File for testing td )‘_\
Technology Services

Lef Le
LL E-T= =N vl v

My Network Save as type: ]

Santa Clara Courty
= Places \‘t’\ QFice of Edwcation

PDLO1O [ D2): View - Any file. Update - Any file.




Creating a prelist file in QSS to test retirement data on the STRS website.

) () [} A L]
File Options Help

b & O #%E .E@@Q

Change
Download Definition | © Dgta] Cateqories ]
Dt S 55 Lires ta retriese | Al -
Access |Include all files j Owrer: |BUCKC - Categary: - ig
nr s
File Name Name Description Records | Owner Category |Access
B [SF436C RSF495  |STRS PREPAYROLL F-495 12,073 [BUCKC PaY COwner

Consider moving to change mode by selecting the green
arrow icon and the deleting the file with the red X icon

After you have created a local file on your PC follow the instructions provided by DBAS to use the STRS website to

test your retirement data. If you have any questions or concerns please contact the Technology Services Help
Desk at 408-453-6748.

N
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Attachment B

Log into CalSTRS Secure Employer Website using the link below:

https://sew.calstrs.com/CalSTRSSewWebUI/Root/Pages/Home.aspx

Click on Manage Files from the Home Menu

Click on the Upload File Tab

File Type: Partial Monthly Report (F496) (only)

Report Period: 10— Apr 2011 (report period is fiscal month)

File: Select the SF496 file that you saved to your desktop from QSS
Click on Upload file to CalSTRS tab to transmit file

The file takes a few minutes to run thru the Business & Integrity Edit Rules, once completed:
Click on the Active Files Tab

Report Unit: Your district

File Type: Partial Monthly Report (F496) (only)

Status: A/l (only)

Search for files by: Date Uploaded then Current Month, click on search

Under File Name click on the file that you just uploaded (typically on the first Upload the Status
is CORRECTION REQUIRED), from the file summary page click on Associated Reports: 2 then
download PDF from the F496 File Detail Report, click on download and print report, proceed to
clear all errors on QSS Pay Lines before re-uploading this file to CalSTRS/SEW again. Your file
Status should be READY TO TRANSMIT before closing payroll.


https://sew.calstrs.com/CalSTRSSewWebUI/Root/Pages/Home.aspx

CalSTRS Secure Employer Web Site - Home

CALS-TRS Secure Employer Web Site

My Account: DLopez (43)

Home . Web Site Information
Welcome, Doris Lopez

Manage Files » )
E o Employer Administrator List

e Congratulations! You have successfully logged onto the CalSTRS Secure Employer Web Site.

Manage Reports This Web site is provided for employers and CalSTRS to communicate member account o File Enforcement
"""""""""""""""""""""""""""" information securely. Many features are provided to assist in protecting and ensuring the

confidential data of our members.

o Release Notes

Authorize Users For information on the latest updates and features be sure to check the Announcements below Quick Reference Items

"""""""""""""""""""""""""""" and for more information, the Release Notes under Web site Information.

REAP _______________________________________ ¢ User Manuals and Training
Employer Notification (1) e FEr ntly Ask ion
"""""""""""""""""""""""""""" Announcements i ificati
- - L]

RErmEEREE Ahice Eile Specifications
-------------------------------------------------- o File Submission and
Secure Message Center (8) Penalties and Interest Update Remittance Schedules
Reference Items Application Downloads
-------------------------------------------------- Regulations- The 45-day comment period for stakeholders to issue written
My Links comments regarding the draft Version 3 penalties and interest regulations ended on .

May 2, 2011 « Employer Application

Suite (Version 2.06

CalSTRS will host a public hearing on June 3, 2011, to receive additional verbal
comments. All comments (written and verbal) will be compiled following the public
hearing and CalSTRS will respond to the comments. Changes to the regulations will
be considered based on the comments received. Any revisions, along with the
comments received, will then be presented to the Board for approval and
submission to the Office of Administrative Law for adoption.

Legislation is pending through two senate bills to revise the regulations to eliminate
the $500 late report penalty and to add language to treat Cash Balance the same as
Defined Benefit.

Business Readiness and Communications- Activities with the Employers
are ramping up with Awareness Infosessions held in April with over 500 report
source and report unit representatives attending. Penalty & Interest Readiness
Assessment calls with report sources have begun and will continue through July.
These calls will continue the process of the identification of potential issues
employers may have with implementing the regulations and will enable the Business
Readiness team to develop process enhancements and other mitigation strategies to
minimize penalty and interest charges.

Please note that new project documentation has been loaded to the Reference
Iltems section of the Secure Employer Web site. This information includes the initial
Frequently Asked Questions (FAQ) document.

Automation-- Configuration and unit testing of the system is underway along with
development of the technical components including forms and reports. Integrated
testing will begin June 13 and continue through two iterations until August 1, plus a
User Acceptance testing cycle in August. The project continues to work toward an
August 15, 2011, system Go Live date, with a July 2012 regulation effective date.

Penalties and Interest Materials

You may view the following Penalties and Interest materials in Reference ltems
under Teachers’ Retirement Law Category:

https://sew.calstrs.com/CalSTRSSewWebUI/Root/Pages/Home.aspx[5/17/2011 2:17:05 PM]
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CalSTRS Secure Employer Web Site - Upload File

| \ :l
( A I STRS Secure Employer Web Site y l'{'\ f} _"-Eta

L St

My Account: DLopez (43) Help | Logout

Manage Files

| Active Files | | Transmitted Files Upload File

.................................................. Specify your File Upload Criteria, and then select Upload Files to begin file Upload.

""""""""""""""""""""""""""""""" File Type: I PARTIAL MONTHLY REPORT(F496) | Data submission info

--------------------------------------------------

REAP

.................................................. Begin Date  End Date
Employer Notification (1) 4/1/2011 4/30/2011
Remittance Advice Fiscal Year: 2010-2011

Secure Message Center (8) —> File: |

Comments:

CJPIDBH file to CalSTRS ) Cancel |

File Uploads may take several minutes to complete.

Note: Once uploaded - your file can be viewed on the Active Files tab for status.

https://sew.calstrs.com/CalSTRSSewWebUI/ManageFiles/Pages/UploadFile.aspx?UploadID=308940740[5/17/2011 2:19:09 PM]
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CalSTRS Secure Employer Web Site - Active Files

‘ A I S Secure Employer Web Site

My Account: DLopez (43)

__________________________________________________ Manage Files

Manage Files — - - -
_____________________________________________ Active Files ransmitted Files Upload File

Search Criteria

"""""""""""""""""""""""""""""" Report Source: 43 Santa Clara Co Office of Ed

-------------------------------------------------- Report Unit: [ an 1
REAP

.................................................. File Type: [ PARTIAL MONTHLY REPORT(F496) |
Employer Notification (3)

.................................................. Status: | ai |

Secure Message Center (8) search for files by: QO All Dates

> ©® Date Uploaded

@current Month
QPrior Month
QOcustom Date Range

From | os/01/2011 | FEE to |os;312011 | EE

From date should not exceed two years from today's date.

QO Report Periods

Annotations: []Display Annotated Files Only

Search Results

Click on the file name to view or download a file.

Items 1-8 of 8 Items/Page: 1 Pagelofl 1
File Name File ' Report| Report | Report Period/ Status Date Uploaded
Type ‘Source‘ Unit PSD / SU Seq # ‘ |
04 43171STRS.dat MO-P 43 43171 10 - Apr 2010-2011 CORRECTION 5/17/2011 02:19:34 PM Delete
REQUIRED
prcatmag0109.txt MO-P 43 43182 10 - Apr 2010-2011 CORRECTION | 05/16/2011 02:53:33 PM Delete
REQUIRED
prcatmag0107.txt MO-P 43 43182 10 - Apr 2010-2011 CORRECTION | 05/16/2011 08:22:03 AM Delete
REQUIRED
STRS0411_20110513.tpe | MO-P 43 43104 10 - Apr 2010-2011 CORRECTION | 05/13/2011 12:51:40 PM Delete
REQUIRED
STRS0411_20110513.tpe | MO-P 43 43104 10 - Apr 2010-2011 CORRECTION | 05/13/2011 11:48:15 AM Delete
REQUIRED
43STRS1110PRELIST3 MO-P 43 10 - Apr 2010-2011 CORRECTION | 05/13/2011 09:38:24 AM Delete
REQUIRED
496 test 5.txt MO-P 43 10 - Apr 2010-2011 CORRECTION | 05/13/2011 09:05:08 AM Delete
REQUIRED
STRD1110.TXT MO-P 43 43152 10 - Apr 2010-2011 CORRECTION | 05/12/2011 02:56:12 PM Delete

https://sew.calstrs.com/CalSTRSSewWebUI/ManageFiles/Pages/ActiveFiles.aspx[5/17/2011 4:31:33 PM]
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CalSTRS Secure Employer Web Site - File Summary

&LSTRS Secure Employer Web Site

My Account: DLopez (43) Help | Logout
. Manage Files Back To File List
Manage Files -
----------------------------------------------- File Summary )
Manage Reports
"""""""""""""""""""""""""""""""" File: 43STRS1110PRELIST3 View File Details| Download Summary Report: Eh

Summary Information

File Type: PARTIAL MONTHLY REPORT (F496)
Report Source: 43 Santa Clara Co Office of Ed
Report Unit:

Date Uploaded: 05/13/2011 9:38:24 AM

Uploaded By: Laurie Sholl

Download Format: Download Original File

Download Current File
Date Transmitted:

Transmitted By:

Expiration Date:
Report Period / PSD / SU Seq #: 10 - Apr 2010-2011
Fiscal Year: 2010-2011
Status: CORRECTION REQUIRED
Total Lines: 19%
Associated Reports: 2
Statistical Information Error/warning guide
Total Integrity Check Errors: 23 Hide Integrity Check Errors.
ID Description Count Correction Required
MO-1004 Service Period Begin greater than Service Period End 1 /
MO-1008 Unit Code is blank or invalid for Source Code on Contribution Line 22 \/
Total Business Rule Errors: 99 Hide Business Rule Error:
Total Business Rule Errors Approved: 0
Total Business Rule Errors Remaining: 99
ID Description Count Approved Remaining Correction Required
MO-B002 No match on Last Name 2 2 v
MO-B007 Member service reported for a non- 7 7 v
member
MO-B008 Non-member service reported for a 5 5 \/
member
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